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ABSTRACT: The abstract (preferably 100-150 words) should comprise a brief and factual account of the contents and conclusions of the paper, as well as an indication of any new information presented, and its relevance. Complete sentences should be used, without unfamiliar jargon.
KEYWORDS: List up to 6 keywords.
InTRODUCTION
We recommend that the paper length be at least five (5) pages - there is no maximum length since the conference proceedings will be circulated only in electronic form. This conference paper will not be peer reviewed. It is our intent that this paper serves as a starting point for a future journal manuscript if you so choose. The level of detail in this conference paper and your journal manuscript should be sufficiently different. The conference organizers will not be facilitating journal submissions (no special issues). Please keep the file size of your conference paper under 64 MB by compressing images. This is necessary for ease of electronic distribution of the proceedings. 
General instructions
Authors of papers should type them using a uniform style that will ease distribution and reading; all papers have to be prepared strictly according to the instructions setout within this document. For the convenience of the authors, this template file for MS Word is provided. The directions in this template generally follow the Instructions for Authors given for the Journal of Wind Engineering and Industrial Aerodynamics.
Type area
The text should be one column and should fit exactly into the type area of 16.51  22.86 cm (6.50”  9.00”). For correct settings of margins in the Page Setup dialog box (Layout menu) see Table 1. 

Table 1. Margin settings for Letter size paper 
Setting								Letter size paper
											cm		inches
Top									2.54  	1.00
Bottom								2.54		1.00
Left									2.54		1.00
Right									2.54		1.00
First paragraph					0.0		0.00
Other paragraphs				0.50		0.20
Style tags for text
The style tags (i.e., Normal text, Heading 1, Figure caption) for this paper have been defined within the template. Authors can access the list along the toolbar at the top of the page (see Figure 1 for screen capture).
To apply a style tag to text, highlight the text to be formatted, then select the style tag to be applied. The text should automatically format to the specifications of the style tag.
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Figure 1. Screen capture with style tags identified across the toolbar at the top of the page.


Type font, size and spacing
All text should be typed in Times New Roman, 12 pt on 13 pt line spacing except for the paper title (18 pt on 20 pt), author(s) (14 pt on 16 pt), and the small text in tables, captions and references (10 pt on 11 pt). Use plain Times New Roman type except for parameters in mathematics (not for log, sin, cos, ln, max., d (in dx), etc.), Latin names of species and genera in botany and zoology and the titles of journals and books which should all be in italics. Never use bold, except to denote vectors in mathematics. Never underline any text. Use the small font (10 points on 11 points) for tables (Table tag), figure captions (Figure caption tag) and the references (Reference text tag).
First lines of paragraphs are indented 5 mm (0.2”) except for paragraphs after a heading or a blank line (First paragraph tag). Never add any space between lines or paragraphs. Never use letter spacing, and never use two consecutive spaces.
Getting started
Preparing the new file with the correct template
Copy the template file to your computer or disk. Start by renaming the document by clicking Save As in the menu Files. Put your sir name in the filename. (e.g., Author.doc). Now you can type your paper, or copy the old version of your paper onto this new formatted file.
Copying old text onto new file
Open both your old file and the new file. Switch between these two with the Window menu. Select all text of the old file and paste to the bottom of the new file. Check the margin setting (Page Setup dialog box in File menu; see Table 1 for correct settings). 
Title, author and affiliation
Papers should be headed by a concise but informative title (preferably one line and no more than two lines). This should be followed by the names of authors and by the name and address of the institution in which the work was performed. This information should be centered on the page. If the address of the author at the time when the paper will appear will be other than that where the work was carried out, this may be stated in a footnote. Acknowledgements for financial support should not be made by a footnote to the title or name of the author, but should be included in Acknowledgements at the end of the paper.
First line of text or heading
If your text starts with a heading, place the cursor on the I of INTRODUCTION and type the correct text for the heading. Now delete the word INTRODUCTION and start with the text after a return. This text should have the tag First paragraph. If your text starts without a heading you should place the cursor on the I of INTRODUCTION, change the tag to First paragraph and type your text after deleting the word INTRODUCTION, but not the return at the end.
Layout of text
Headings
Type primary headings in capital letters Roman (Heading 1 tag) and secondary and tertiary headings in lower case italics (Headings 2 and 3 tags). Headings are set flush against the left margin. The tag will give two blank lines (26 pt) above and one (13 pt) beneath the primary headings, 1½ blank lines (20 pt) above and a ½ blank line (6 pt) beneath the secondary headings and one blank line (13 pt) above the tertiary headings. Headings are not indented and neither are the first lines of text following the heading indented. If a primary heading is directly followed by a secondary heading, only a ½ blank line should be set between the two headings. In the Word program, this has to be done manually as follows: Place the cursor on the primary heading, select Paragraph in the Format menu, and change the setting for spacing after, from 13 pt to 0 pt. In the same way the setting in the secondary heading for spacing before should be changed from 20 pt to 7 pt.
Listing and numbering
When listing facts use either the style tag List signs or the style tag List numbers.
Equations
Use the equation editor of the selected word processing program. Equations are not indented (Formula tag). Number equations consecutively and place the number with the tab key at the end of the line, between parentheses. Refer to equations by these numbers. See for example Equation 1 below:

	(1)
where ca = interface adhesion;  = friction angle at interface; and k1 = shear stiffness number.
For simple equations in the text always use superscript and subscript (select Font in the Format menu). For example: From the above we note that sin  = (x + y)z. Do not embed equations from the equation editor in the text on same line.
Photographs and figures
Number figures consecutively in the order in which reference is made to them in the text, making no distinction between diagrams and photographs. Figures should fit within the type area width of 16.51 cm (6.50”).
Figures, photographs, etc. can be pasted into the document where you want them to appear in the text. Photographs should be of good quality, with good definition. Color figures and photographs may be used. Do not place figures sideways on a page; however, if this cannot be avoided, no other text (except the figure caption which should also be placed sideways) should appear on that page. Figures, etc. should not be centered, but placed against the left margin. Leave about two lines of space between the actual text and figure (including caption). Never place any text next to a figure. Leave this space blank. The most convenient place for placing figures is at the top or bottom of the page. Avoid placing text between figures as readers might not notice the text. Line drawings (as well as photographic reproductions of these) should be in black (not gray) on white. The minimum size of lettering in figures should be 9 points. Lines should preferably be 0.2 mm (0.1”) thick. Keep figures as simple as possible. Avoid excessive notes and designations.
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Figure 2. Caption of a typical figure. 

Figure captions
Always use the Figure caption style tag (10 points size on 11 points line space). Place the caption underneath the figure (see Section 4). Type as follows: ‘Figure 1. Caption.’ Leave about two lines of space between the figure caption and the text of the paper.
Tables
Locate tables close to the first reference to them in the text. Careful thought should be given to the layout of Tables (and Figures) so that the significance of the results may be quickly grasped by the busy reader. Often a Table of results can be understood more readily if columns and lines are interchanged. Tables should be numbered with Arabic numerals (e.g., 1, 2, 3) and should have headings that make their general meaning understandable without reference to the text. The units in which results are expressed should be given at the top of each column (in parentheses) and not repeated on each line of the Table. Avoid abbreviations (except for units) in column headings. (For more instructions regarding units, see Section 5 Symbols and Units). Footnotes should be indicated by the use of lower-case letters (a, b, c, etc.), as superscripts without parentheses. 
Use only horizontal rules: one above and one below the column headings and one at the foot of the Table (Table rule tag: Use the Shift-minus key to actually type the rule exactly where you want it). For simple Tables, use the tab key and not the Table option. Type all text in Tables in small type: 10 on 11 points (Table text tag). Align all headings to the left of their column and start these headings with an initial capital. Type the caption above the table to the same width as the table (Table caption tag). See for example Table 1.
Conclusions
Conclusions should state concisely the most important propositions of the paper as well as the author’s views of the practical implications of the results.
UNITS
Follow internationally accepted rules and conventions: use the international system of units (SI). If other quantities are mentioned, give their equivalent in SI.
acknowledgements
This template has been used for several conferences, but is based on that used for CWE2006, which was held in Yokohama and chaired by Professor Yukio Tamura.
References
References should be collected together in a reference list (headed REFERENCES) and arranged alphabetically by name followed by the year, at the end of the paper. The references should be typed in small text (10 pt on 11 pt) and second and further lines should be indented 5.0 mm (0.2”) (Reference text tag).
Footnotes and legends should not include bibliographic material, and reference lists should not include material that could more appropriately appear as a footnote. Authors should ensure that every reference appearing in the text is in the list of references, and vice versa. Numerals for references are given in square brackets; numerals referring to equations are enclosed in parentheses. 
The following system of giving references is required:

Journals
M.E. Greenway, An analytical approach to wind velocity gust factors, J. Ind. Aerodyn., 5 (1979) 61-91.
(Journal titles will be abbreviated in accordance with the Engineering Index system. Authors unfamiliar with this system may give full titles without abbreviation.)

Monographs, Multi-author volumes, Proceedings
W. Bach, Atmospheric Pollution, McGraw-Hill, New York, 1972, p. 94.
G.R. Lord and H.J. Leutheusser, Wind tunnel modeling of stack discharge, In M.A. Ward (Ed.), Man and his Environments, Pergamon, Oxford, 1970, Vol. 1, pp. 115-125.
M.E. Davies, V.G. Quincey and S.J. Tindall, The near-wake of a tall building block in uniform and turbulent flows, In J.E. Cermak (Ed.), Proc. 5th Int. Conf. on Wind Engineering, Fort Collins, CO, 1979, Pergamon, Oxford, 1980, Vol. 1, pp. 289-298.

References to a “private communication” are not to be given. A “personal communication” should be referred to only when permission has been obtained from the person who made the personal communication. A reference to “in press” implies that the paper has been accepted for publication.
In the text, an author’s name is given without initials, except where it is wished to avoid confusion with namesakes.
When reference is made to a publication written by three or more authors, it is preferable to give only the first author’s name in the text, followed by et al., or the name of one of the authors, followed by “and co-workers”. In the list of references, the names and initials of all authors must be given.
Consistency of style is very important. Note the spacing, punctuation and caps in all the examples below.
· References in the text: Figure 1, Figures 2-4, 6, 8a, b (not abbreviated)
· References between parentheses: (Fig. 1), (Figs 2-4, 6, 8a, b) (abbreviated)
· USA / UK / Netherlands / the Netherlands instead of U.S.A. / U.K. / The Netherlands
· Author & Author1 instead of Author and Author1
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